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WARNING!

The purpose of this software, hereafter referred to as Gearify, is to hypothesize the shapes
of interlocking gear mechanisms. While most reasonable designs will produce gears that will
interlock smoothly, the mechanisms designed and calculated via Gearify are not guaranteed to
be reliable or safe. Gearify can occasionally produce designs that will be depicted as smoothly
interlocking mechanisms, but will slip apart, or grind to a halt, when made into physical models.
While parameters can be adjusted to produce highly accurate designs, Gearify is not explicitly
designed for industrial grade mechanisms. The creation of gears for industrial applications is
a highly developed engineering science. Gearify is only partially based on this science, and
instead relies on an original approach using Differential Equations, Numerical Methods, and
Computational Geometry in order to allow more freedom of design. In any situation, building
and operating machines is potentially dangerous. Gears have the capacity to generate massive
amounts of torque which can pinch and crush. It is entirely up to you (the end user) to verify the
suitability, reliability, and safety of any design explicitly or implicitly suggested by Gearify, for any
application. The developer(s) of Gearify are in no way responsible for any injuries or accidents
involving any machine which contains designs produced by Gearify, whether those designs are
explicit or implicit. In short, building any design suggested by this software is completely at
your own risk!

Before you purchase

Gearify is provided as an evaluation version which contains all the features of the full
version, except that it adds a slight visual distortion, or ’wobble’ to the display of calculated
designs, and disables the ability to save and export designs to DXF, CSV and .gearify files.
Purchasing a product key from www.gearifysoftware.com removes these limitations. If you are
interested in purchasing the full version, be absolutely sure you install and test the evaluation
version extensively BEFORE making your purchase. You ARE NOT entitled to a lifetime
of service by purchasing a license and you MAY NOT re-distribute or sell the design files (or
derived design files) exported from Gearify. You are, however, permitted to re-distribute or sell
physical parts, models and mechanisms created using Gearify’s exported design files. Future
versions of Gearify may utilize a different sales model and Gearify may, but is not obligated, to
provide licensed users with free access to these future versions. Instead, Gearify will endeavor to
provide a minimum of 1 year of functional and supported software, but only as time allows and
not by obligation. The software is provided as is, without warranty.
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Chapter 1

Installation and Activation

Gearify is very easy and fast to install and activate but step by step instructions are
provided for extra clarity and convenience.

1.1 Installing on machines with an Internet connection

Step 1

Go to www.gearifysoftware.com and download the free evaluation version. Right click
the downloaded zip folder Gearify.zip and click Extract or Extract all to unzip it (this
may vary depending on what compression software you have installed on your machine).

Step 2

To install Gearify, you must first uninstall any previous version of Gearify that is installed
on your machine. If you have a previous version installed, go to the Add/Remove Programs
section of Windows (often found inside control panel). Search for Gearify and click uninstall.
Follow the instructions to complete the uninstallation. Now open the Gearify folder you un-
zipped in step 1 and double click the setup file to begin installation. Follow the instructions
to complete the installation. You must agree to the terms of the license agreement. Once the
installer completes, you should see a Gearify icon on your desktop and in your start menu.
Double click on either to open the software. Evaluate it thoroughly on your machine to make
sure it functions properly. I recommend following the Users Guide from start to finish (with
the exception of the exporting sections which require activation) before purchasing a product
key.

Step 3 (If you have errors, otherwise proceed to Step 4)

When you start Gearify, you may get an error message that says something along the
lines of: To run this application you must first install one of the following versions of the
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.NET framework: v4.0. This means you do not have the .NET 4.0 framework installed on
your machine which is required to run this software. If this occurs, you will need to go to:
http://www.microsoft.com/en-us/download/details.aspx?id=17851 Or if that link fails,
Google ".NET 4.0 web installer". Follow the installation instructions and when you are done,
re-attempt to open Gearify. It should open without trouble at this point.

You may experience slowness or freezing of the software when images or textures are being
displayed on screen. You may also experience blank images. This likely means your display
drivers need updating. The steps for updating your display drivers will vary per machine so you
will need to research this topic online. Generally you need to determine what graphics hardware
you have (make and model) download the appropriate driver installer from the maker’s website,
and install it on your target machine. If you are still having errors, restart your computer and
attempt to run Gearify once more. If all else fails, email a clear description of your problem and
any error messages you are receiving to: postmaster@gearifysoftware.com

Step 4

Once you are sure that Gearify works on your target machine, you are satisfied with the
software product, and you wish to activate the full version, go to www.gearifysoftware.com
and purchase a product key. The payments page will carry out the transaction using Paypal,
and it will walk you through the payment process. It will conclude by emailing you a product
key. To activate, follow the activation instructions in the next section.

1.2 Activating on machines with an Internet connection

• Open Gearify.

• Click the Activate tab at the top.

• Click the Activate... button.

• In the activation window that appears, click Activate Gearify Online Now.

• On the next screen you will be prompted for a product key. Paste your product key (the
one that was emailed to you when you made your purchase) into the textbox, and click
Next.

• Follow the instructions and you should soon see an Activation Successful! screen. If so,
congratulations, you have successfully installed and activated the full version of Gearify!

1.3 Installing Gearify on Machines without an Internet
connection

It is possible to install and activate Gearify on a machine without an internet connection.
The process is still simple, but requires more steps (as well as a flash drive or other external
device). The short story is that you will have to save the evaluation version to a flash drive or
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external device, copy it to the machine without an internet connection and run the installer. To
active, you must enter your product key in Gearify and save an activation request file to your flash
drive or external device. You will upload this activation request file to www.gearifysoftware.com
and it will give you an activation response file. You then re-open Gearify and submit your
activation response file to complete the activation. For a detailed walk through, see the steps
below.

Step 1

• On a machine with an Internet connection, go to www.gearifysoftware.com and download
the evaluation version.

• Save the downloaded file Gearify.zip to a flash drive or external device.

• Disconnect your flash drive or external device.

Step 2

• Connect your flash drive or external device to the machine you wish to install it on (the
one without an internet connection). We’ll refer to this as the target machine from here
on.

• Copy the file Gearify.zip to your machine (to My Documents for example). Right click
the zipped folder and click Extract or Extract all to unzip it (the unzipping process may
vary depending on what compression software you have installed on your machine).

Step 3

• Uninstall any previous version of Gearify that is installed on your machine. If you have a
previous version installed, go to the Add/Remove programs section of Windows (often
found inside control panel) Search for ’Gearify’ and click uninstall. Follow the instructions
to complete the uninstallation.

• Open the Gearify folder you unzipped in Step 2 and double click the setup file to begin
installation. Follow the instructions to complete the installation. You must agree to the
terms of the license agreement.

• One the installer completes, you should see a Gearify icon on your desktop and in your
start menu. Double click on either to open the software. Evaluate it thoroughly on your
machine to make sure it functions properly. I recommend following the Users Guide from
start to finish (with the exception of the exporting sections which require activation) before
purchasing a product key

Step 4 - If you have errors, otherwise skip to Step 5

• When you start Gearify, you may get an error message that says something along the
lines of: To run this application you must first install one of the following versions of the
.NET framework: v4.0... This means you do not have the .NET 4.0 framework installed
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on your machine which is required to run this software. If this occurs, you will need to
go to http://www.microsoft.com/en-us/download/details.aspx?id=17718 Or if that
link fails, Google ".NET 4.0 Standalone installer" (you cannot use the web installer since
your target machine does not have an internet connection). You will have to download and
save the .NET 4.0 installer to a flash drive, transfer it to your target machine, open it,
and run the installer. Once it is complete, Gearify should open without trouble.

• You may experience slowness or freezing of the software, especially when images or textures
are being displayed on screen. You may also see blank images. This likely means your
display drivers need updating. The steps for updating your display drivers will vary per
machine so you will need to research this topic online. Generally you need to determine
which graphics hardware you have (make and model) download the appropriate driver
installer from the makers website, and install it on your target machine. If you are still
having errors, restart your computer and attempt to run Gearify once more. If all else
fails, email a clear description of your problem and any error messages you are receiving
to: postmaster@gearifysoftware.com

Step 5

Once you are sure that Gearify works on your target machine, you are satisfied with the
software product, and you wish to activate the full version, go to www.gearifysoftware.com
and purchase a product key. The payments page will carry out the transaction using Paypal,
and it will walk you through the payment process. It will conclude by emailing you a product
key. To activate, follow the activation instructions in the next section.

1.4 Activating Gearify on machines without an Internet
connection

Step 1

• After you have purchased a product key (Be sure you evaluate and test the software before
doing so) Copy your product key from the email that was sent to you, and paste it into a
simple text editor (such as notepad). Save the file (call it gearify-product-key.txt) to a
flash drive or external device.

• Open Gearify on the machine you wish to activate it on (Hereafter referred to as the target
machine).

• Click on the Activate tab at the top of Gearify.

• Click the Activate... button.

• You will see a new window appear with a list of options. Click on Other Options...

• On the next screen select Manually activate Gearify offline

• You will be prompted to enter a product key. Connect your flash drive or external device
to your machine and open the gearify-product-key.txt file you saved it earlier. Copy
the product key from this file and paste it into the Activation screen and click next.
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• In the next screen you will be asked to either open or save the activation request. Click
Save the Activation Request file and save the file ActivationRequest.xml to a flash
drive or external device so you may transfer it to a machine with an internet connection.

• After you save, you will see a dialog asking you to Send this file to Gearify Software to
get the Activation Response file. You certainly may do this but it is actually easier and
faster for you to obtain the activation response file yourself. Proceed to the next step to
learn how.

Step 2

• Connect your flash drive or external device containing your ActivationRequest.xml file
to a machine with an internet connection.

• Go to www.gearifysoftware.com. You will see a link on the main page that says No
internet connection? Manually activate, or something to that effect. Click this link.

• On the following screen, you will be asked to either upload the ActivationRequest file,
or paste the contents into a text box. I suggest clicking Browse, selecting your Activa-
tionRequest.xml file (which you saved on your flash drive or external device) and clicking
Open.

• Once you have uploaded the ActivationRequest.xml file or pasted its contents into the
textbox, click Activate. If all went well, you should see a screen that says Activated
Successfully! (If you do not see this, return to Step 1 and make sure you entered the
correct product key and that your product key is valid. Remember you may have up to 2
activations per license).

• Gearify software has now confirmed your activation is valid, but you have a little more
to do. Click Download the ActivationReponse XML file. Save the downloaded file
ActivationResponse.xml to your flash drive or external device.

• Disconnect your device and return to your target machine.

Step 3

• Connect your flash drive or external device containing your ActivationResponse.xml
file to your target machine.

• Open Gearify and click the Activate tab.

• Click the Activate... button.

• Click Other options on the Activation window that appears.

• Click Manually activate Gearify offline

• Click Open the Activation Response file.

• Browse to the file ActivationResponse.xml saved on your flash drive or external device,
then click Okay.

• You should see a confirmation screen saying "Activation was successful". If so, congratula-
tions, you have successfully installed and activated the full version of Gearify.
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Chapter 2

Quick Start Guide

Feeling impatient? This Quick Start guide shows you how to use a few of the most common
and user friendly design options and will have you making gears in seconds!

2.1 Creating gears using Free Draw

• Click the Design tab if not already open.

• Click the Draw tab in the Base Curve section.

• Click the black display area in several places to add spokes to generate a curve. Right click
to remove a highlighted spoke. You need at least 3 spokes before a gear shape will appear.

• Click the Calculate Gear tab at the top.

• Click Create Gear.

2.2 Create a gear using an Image

• Click the Design tab if not already open.

• Click the img tab in the Base Curve section.

• Upload an image of your choosing. (The image must have a solid colored background that
is distinctly different from the contents).

• Click Read Image and wait for a gear shape to appear. Enter a small offset value (-1 or
-2) and click Offset.

• Click on the Calculate Gear tab at the top.

• Click Create Gear.
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2.3 Create a gear using DXF

• Click Design tab if not already open.

• Click the dxf tab in the Base Curve section.

• Click the DXF button and browse to a file containing a smooth curve with no teeth. The
file must contain only a single closed curve which contains the origin (0,0)..

• Option 1 : If you want to use the auto-calculated teeth, click the Calculate Gear tab and
click Create Gear. Skip the remaining steps.

• Option 2 : If you want to upload your own full tooth outline, click on the Import Full
Outline tab in the Teeth Outline section at the bottom. Click Browse and select a
file. The file should contain the entire gear shape with teeth. It must be the same size and
location as the base curve. The base curve should fall roughly inside the midpoint of the
teeth.

• Click on the dxf tab in the Base Curve section once again (even if already open) to see
the base curve and tooth outline together, and make sure they line up.

• Click on the Calculate Gear tab and click Create Gear .

2.4 Pan-Zoom Controls

Almost all of the visual feedback provided in Gearify is shown in the large black display
area to the right of all the interface controls. Usually when something is shown here, you can
use the Standard View Controls. They are:

• Double click on the display area to zoom in.

• Right click on the display area to zoom out.

• Drag on the display area to pan.

• Click once on the display area and press ??to zoom-all. This should reset your view so that
all the interesting content is visible and easy to see.

There are a few design modes where the standard view controls are disabled, but all of these
modes feature a Pan-Zoom check-box which allows you to re-activate the standard view con-
trols.
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Chapter 3

The Basics

This chapter explains the basic structure of Gearify and should greatly demystify all the
available options.

Gearify works as follows. You design a Known Gear and set a few simple parameters.
Then you click a button that says Create Gear. Gearify then calculates a Conjugate Gear to
mesh together with your Known Gear. You then inspect the resulting gear mechanism carefully
and when you are satisfied, save or export your results. You must provide 4 things:

1. A Base Curve. A smooth curve representing the overall shape of your gear. Or what
your gear would look like ?ithout teeth?

2. A Tooth Outline. A full outline of the shape of your gear, teeth and all. By default, this
is automatically generated from your Base Curve.

3. A Rotation Ratio. This is the ratio of the number of rotations of the Known Gear, per
rotations of the Conjugate Gear.

4. An Internal indicator. A simple check box to indicate if you want the Known Gear to roll
along the interior of the Conjugate Gear.

Let? have a more detailed look at each of these.

3.1 The Base Curve

The base curve is necessary for certain calculations that Gearify performs. The base curve
must be relatively smooth and should follow along roughly the midpoint of the tooth outline.
The base curve MUST have its center of rotation at the origin (0,0). It is permissible to have
sharp corners and discontinuities in your base curve, but these sometimes lead to less satisfactory
results. Gearify offers 7 ways to design base curves to offer maximum design flexibility. They
are:

• Polar functions

• Free Draw

12



• Parametric Functions

• Implicit Functions (Math savvy users only)

• Image Upload

• CSV Upload

• DXF Upload

I encourage users to explore all available design options (Except maybe for Implicit Functions)
because each method provides new and interesting designs that may not have occurred to you
using another design method. You do not need to be a math genius to use the Polar or Parametric
design options. Instructions are provided for the non-math savvy user. You can find more
information about each of these design modes in the Base Curve Design Modes Chapter.

3.2 Tooth Outline

The tooth outline is quite plainly the shape of your gear. The tooth outline (as its name
would suggest) typically features teeth, but this is not technically necessary. It must be at the
same location and size as the base curve. The center of rotation must be at the origin. Generally
speaking there are 3 ways to provide the tooth outline:

1. Calculate from base curve. The default behavior for creating your tooth outline is that
it is automatically calculated from your base curve. This is provided to allow quick and
easy design, but you may have to adjust the parameters to obtain aesthetically pleasing
results. There are many options to design the shape of the teeth which are used to produce
the tooth outline, so see the Tooth Design section on that.

2. Manually upload tooth outline. If you want to take full design control over your tooth
outline, you may upload it as either a DXF or CSV file. You may use any of the base curve
design options in combination with your manually uploaded tooth outline.

3. Use the base curve as the full outline. In some instances, the user may want to
create some sort of artistic display which features smooth, irregular shapes rolling together.
Perhaps they would be connected to toothed versions of themselves which are concealed
from view. For completeness this option is available.

3.3 Rotation Ratio

The rotation ratio is a fraction which gives the number of rotations of the known gear per
rotations of the conjugate gear. For example: If the rotation ratio is: 2/5, then your known gear
will complete 2 full rotations for every 5 rotations of the conjugate gear. By design, you only
get to specify the numerator (Top number, 2) in the above ratio. The denominator (Bottom
number, 5) is determined by the symmetry of your gear. The denominator is intimately related
to symmetry, so see the Gear Symmetry section for more info on that.
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3.4 Internal Indicator

To indicate that you want your known gear to roll along the inside of the conjugate gear, you
can check the Internal checkbox in the Calculate Gear tab. Currently, only the known gear
can be on the inside. The option of having the conjugate gear on the inside may be featured in
a later revision.
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Chapter 4

Base Curve Design Modes

The Base Curve design section is the primary means of designing your gear shapes. In
this chapter we will explore the various design modes available. When you open Gearify, on the
Design tab, in the Base Curve section you will see 7 tabs, each with unique design modes.
They are:

• f(t): Polar functions

• draw: Free Draw

• param: Parametric Functions

• implic: Implicit Functions (Math savvy users only)

• img: Image Upload

• csv: CSV Upload

• dxf: DXF Upload

Gearify is designed to let you simultaneously experiment with the various design modes. Whichever
of the above tabs is currently selected, is considered the ?urrent?base curve, and is the curve
that will be employed when you click the Create Gear button. The Rotation Ratio in the
Calculate Gear tab will also remember which rotation ratio you used for each design mode, as
you switch between tabs.

The Base Curve design section features a sample points slider control, and a Color box.
Most design methods make use of the sample points value when computing curve shapes in
various methods. See each individual design mode’s description to learn if and how the sample
points value is used. The Color determines what color the base curve is drawn with inside the
display area.

4.1 F(t): Polar Functions

This is a mathematical means of describing gear shapes but don’t worry if you are not a
mathematician or engineer! Easy instructions are provided for non-math savvy users. To enter
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this mode click the Design tab then click the f(t) tab.

Instructions for Math Savvy Users

Enter a function of t into the r(t) text box and click graph curve. The function will be
evaluated from t = 0 to (2π). I recommend expressions involving sines and cosines, such as:

r(t) = 7 + sin(3t) + 2cos(2t)

For a list of all the functions available, see the expression parser info.

Instructions for Non Math Savvy Users

Fear not! This requires no voodoo calculations or solving for x. Have you ever played with
a graphing calculator? This is exactly the same. Click on the textbox beside r(t) and type a
single number. 12 is a good number! We?l call this the leading constant Now what we?l do is
add wave forms to that. Waveforms look like the following:

• 2cos(3t)

• 6sin(7t)

• cos(4t)

• 13sin(2t)

The number in front of cos or sin is called the amplitude. The number next to the t is called the
frequency. So the waveform 2cos(3t) has an amplitude of 2 and a frequency of 3. Let? add two
waveforms: 2cos(3t) and 3sin(6t) to our expression:

r(t) = 12 + 2cos(3t) + 3sin(6t)

And that? all you have to do! Experiment with different waveforms for more interesting results.
If you get a message that says Warning! Negative radius, increase the leading constant (12)
value to something larger, or shrink your amplitude values, then click Graph curve again. You
can also add exponents to your waveforms using the ˆ symbol. For example you might try:

r(t) = 12 + 2cos(3t)ˆ3 + 3sin(6t)ˆ2

I would keep your frequencies relatively small (less than 13) and your exponents small as well.
Your leading constant should probably be larger than the sum of the amplitudes. (In the above
expression, the leading constant is 12 and the sum of the amplitudes is (2 + 3) = 5). You can
also multiply waveforms together by wrapping them in parenthesis and added a between them,
for even more interesting results, such as the following:

r(t) = 12 + 0.5(cos(3t) + 2)2(3 + cos(2t)2 + sin(t))

The sky is the limit really.
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Notes on Symmetry

If you want your gear shape to possess a particular symmetry value, you can achieve this
by using wave forms where all frequencies are divisible by the symmetry value. Don? bother to
understand why. If you are not math savvy just take it as a fact. For example, in the following
equation:

r(t) = 3 + sin(3t) + cos(6t)

. All frequencies (3 and 6) are divisible by at most 3, so this shape will produce 3 repeating
patterns, yielding a symmetry value of 3. On the other hand, the equation

r(t) = 4 + cos(5t) + sin(2t)

has a symmetry value of only 1 because there is nothing higher than 1 that evenly divides both
5 and 2. If the auto symmetry box does not correctly compute the symmetry, you can uncheck
auto and enter the symmetry value manually before clicking graph curve again. However, take
a moment to consider carefully if the auto symmetry detection was actually incorrect. Some
designs such as ellipses have an apparent symmetry of 4 but in terms of radial symmetry, it?
actually 2.

4.2 Draw: Free hand drawing

This is an easy design option that lets you design gears with just a few clicks in a matter
of seconds! To enter this mode click the Design tab then click the draw tab.

Instructions

Move the mouse over the black display area. Left click to add spokes. After you?e added
3 spokes, you will see a curve generated. Click again to add more spokes, or right click to
remove a highlighted spoke. The spoke nearest the mouse is the one that is highlighted. Click
clear to remove all spokes (and your stencil, if one exists) and start again. Normal pan-zoom
controls are disabled for this view, so click pan-zoom to disable the draw controls and enable
the usual view controls. Uncheck to resume drawing. While in this mode, you can select 3 types
of symmetry. Only the radial option relates to the gear symmetry value which influences the
rotation ratio. Check horiz for horizontal symmetry. This is ?eft-right?symmetry. Any spoke
you add or delete on the right will be duplicated on the left and vice versa. Check vert for
vertical symmetry. This is ?op-bottom?symmetry. Any spoke you add or delete on the top will
be duplicated on the bottom and vice versa. Check radial for radial symmetry. You can set
the number of divisions in the textbox beside it. This is what determines the gear symmetry
when determining rotation ratio in the Calculate Gear tab. If your divisions value is n,
then each spoke you add or delete will be repeated at every 360

n degrees. So for example if you
divisions value is 4, then each spoke will be repeated at every 360

4 = 90 degrees.

Using Stencils

It is possible to upload a stencil into your drawing area so that you can trace the edges of
an image. This is useful when you are basing your design from an image, but the image does
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not possess the desired features to be calculated in the Image Upload design mode. To add
a stencil, click the img button inside the Stencil box and navigate to an image file. (Most
standard image file types are supported). After you?e selected an image, you can enter the pixel
coordinates of where you want the center of the gear to be in the X and Y textboxes. Or you
can click cent to make the center of the gear at the center of the image (Default).

A s when using Image Upload you can enter an offset amount. Enter a small percentage
(like 1 or 2%) and click the offset button. This percentage is relative to the overall size of the
gear, which is determined by the maximum distance from the center of the gear to its edge. The
reason for this feature is that the tooth outline tends to extend beyond the base curve and so
to keep the teeth fully contained within the image, you may offset the base curve slightly. The
stencil (if one exists) will be used as a texture for the known gear, after the conjugate gear is
generated.

Notes on Symmetry

This mode does not contain an auto-symmetry calculation because it is extremely rare that
the user would produce a radially symmetric design unless using the radial symmetry option.
For this reason, symmetry is determined explicitly by the divisions parameter. If you do not
want this symmetry detection to occur, simply uncheck the radial symmetry option and click
Add Teeth under the Calculate Teeth tab at the bottom, before moving to the Calculate
Gear tab.

4.3 Param: Parametric Functions

Similar to Polar Functions this is a mathematical design mode, but you do not need to
be a mathematician or engineer to use it. Instructions are provided for the non math savvy user.
To enter this design mode click the design tab and then click param.

Insructions for Math savvy users

Enter two parametric functions for x(t) and y(t) then click graph. The function is evalu-
ated from t = 0 to (2π). The number of sample points to generate the curve is determined by
the sample-points slider control. Intermediate values are interpolated.

Instructions for Non Math savvy users

First read the instructions for the base curve design mode F(t): Polar functions. This
graphing method is mostly the same. You enter your expressions and then click graph. But this
design mode is different from polar functions in three ways. First, you have two expressions to
enter. One for x(t) and one for y(t). For example:

x(t) = 12cos(t) + sin(3t) + cos(2t)

y(t) = 12sin(t) + cos(2t) + 0.5sin(t)
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Second, the leading contant described in the design mode F(t): Polar functions must
have a cos(t) in front for the x(t) expression, and a sin(t) in front for the y(t) expression (notice
the 12 in both the above expressions). You can even make the leading constant different for x(t)
and y(t) which will make the shapes more elliptical. Be careful about adding lone constants in
your expression. For example if you use:

x(t) = 5cos(3t) + 7

The 7 will shift the graph 7 units to the right (this can be a problem since your base curve
needs to contain the origin). You probably want to avoid having constants like these in your
expressions, unless you want a slight shift. So in short, if you add constants, make them relatively
small.

Third and finally, you cannot use the ?requency rule?discussed in the ?olar functions?section,
to get a desired symmetry value, as explained below.

Notes on Symmetry

With parametric functions, there is no easy way to generate curves with any particular
symmetry value, unlike polar functions. The auto-symmetry will attempt to detect symmetries.
Once again, you can enter it manually if the auto-detect fails, but carefully consider if the
auto-symmetry was correct. See Gear Symmetry for more info.

4.4 Implic: Implicit functions (Math savvy users only)

This somewhat crude design mode is offered for completeness. To enter this design mode
click the Design tab and then click implic. The equation is given in terms of x and y and is in
the form f(x, y) = 0. If you have a two sided implicit equation such as g(x, y) = h(x, y) then let
f(x, y) = g(x, y)?h(x, y) and enter this. A useful method is to start with:

f(x, y) = xˆ2 + yˆ2?10

and then add small perturbations to the equation to morph the shape. The evaluation radius
gives the range of values centered at the origin to test while searching for the zeros of f(x, y).
Click graph and a curve will be generated slowly. The num sample points slider will determine
how many points on the curve are calculated.

Notes on Symmetry

There is no easy way to generate curves with any particular symmetry value, unlike polar
expressions. The auto-symmetry will attempt to detect symmetries. Once again, you can enter
it manually if the auto-detect fails, but carefully consider if the auto-symmetry was correct.
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4.5 Img: Image Upload

This one? a crowd pleaser. In this mode you can use simple image files to generate gear
shapes! Click the Design tab and then click the img tab to enter this design mode.

Begin by clicking the Image button. You can upload images in most common formats (jpg,
png, bmp, gif, tiff, etc.). Your image must contain a solid background color that is at least slightly
different than the main contents of the image. For this reason, photographs are generally not
suitable unless taken against a bright, uniformly colored background (Otherwise, see the design
mode Draw: free draw and use a stencil image). Ideally the main content of your image should
be at the center. Note in this view, the standard pan-view-controls are disabled, unless you click
the pan-zoom checkbox. Left-click on the image to set your gear center point. The crosshairs
will show where you selected. Alternatively you can type in the desired gear center in pixel
coordinates, or press cent. to make it the center of the image (the default).

If Gearify does not correctly detect your background color, right click the background on the
image to read the color. The color of the crosshairs should match the background.

This is a place where you will definitely want to experiment with the sample points slider
control at the top of the design tab. Reading an image at 360 radial divisions can produce
sloppy results especially if the image is low resolution. For this, consider lowering the number of
sample points to 180, 90 or even 45.

Lastly you must adjust the tolerance, which is a value between 0 and 1. Use a high image
tolerance (0.5 or higher) when there is stark contrast between the content of the image and the
background (like a black image with a white background). Use a low tolerance when there is
only a slight difference between the content of the image and the background (like a light-gray
image with a white background) Experimenting with image tolerance will be key to reading
the shape as you desire it. (A technical description of the tolerance is that it is the maximum
Cartesian distance within the color-cube that a pixel can deviate before it is recognized as a
non-background pixel). The background color is defined as the color of the upper-left-most pixel
in the imported image.

Once you have selected the gear center point, adjusted the number of sample points, and the
tolerance, click the Read Image button and the gear shape will be determined from the image.
Moreover, the same image will be used as a texture in the View mode after your conjugate gear
is calculated. Keep in mind, whenever you change any of the parameters, such as the number
of sample points, the tolerance, or the image center, you will need to click Read Image once
again to re-generate the curve.

It is worth mentioning that sometimes the color of the base curve or the tooth outline can
match the image, and it is helpful to change the color to make them more visible.
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Once the image read is complete, enter a small offset percentage beside the Offset button
(try -1 or -2) and then click the button. This percentage is relative to the overall size of the
gear, which is determined by the maximum distance from the center of the gear to its edge. The
reason for this feature is that the tooth outline tends to extend beyond the base curve and so to
keep the teeth fully contained within the image, you offset the base curve slightly.

Notes on symmetry

Symmetry is a rare occurrence with images but auto-detect is still featured for this. Once
again, you can enter it manually if the auto-detect fails, but carefully consider if the auto-
symmetry was correct. See Gear Symmetry for more information.

4.6 Csv: CSV Upload

This mode lets you create gears using files containing comma separated values (CSV). Click
the Design tab then click the csv tab to enter this mode.

Simply click the CSV button to upload a file of comma separated x, y coordinates, with one
vertex per line. For example, suppose square.csv contains the following text:

-1,-1
1,-1
1,1
-1,1

This will produce a square shaped base curve. This is very useful if you want to use the result
of a previous gear calculation as input for a new calculation. See Chaining Gears

Notes on symmetry

Symmetry auto-detect is enabled. You can enter it manually if the auto-detect fails, but
carefully consider if the auto-symmetry was correct. See Gear Symmetry for more details

4.7 DXF: Upload DXF

This design mode lets you upload DXF files so you are free to design gear shapes using
your favorite CAD software! Click the Design tab then click the dxf tab to enter this design
mode.

Adjust the sample points slider at the top as desired (though the default value 360 should
be suitable). Click the DXF button and browse to a DXF file. Open your file and your base
curve will appear in the display. Should you choose to adjust the number of sample points,
you will have to re-upload the DXF file.
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This design mode is very useful if you want to use the result of a previous gear calculation as
input for a new calculation. See Chaining Gears.

Notes on symmetry

Symmetry auto-detect is enabled. You can enter it manually if the auto-detect fails, but
carefully consider if the auto-symmetry was correct. See Gear Symmetry for more details.
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Chapter 5

Tooth outline Design

At the bottom of the Design tab is the Tooth Outline section. There are three tabs:

• Options

• Calculate Teeth

• Import Full Outline

Let’s have a brief look at each!

5.1 Options

In the options tab you can select your mode for how to supply your tooth outline. The first
(default) option is auto calculate teeth. This means the tooth outline will automatically be
deduced from your base curve, using the design settings in the Calculate Teeth tab. The
second option, same as base curve, means your tooth outline will essentially contain no teeth
and will match the base curve. This is probably not of much use to most users but is provided
for completeness. The third and final option is uploaded outline. This will be grayed out
initially, and automatically activated if you upload a full tooth outline.

5.2 Calculate Teeth

The Calculate Teeth tab offers a wide variety of options for tooth design. For starters there
is the Teeth number which by default is set to 32. This is the approximate number of teeth
that will be generated along your base curve (the exact number may vary based on symmetry
value and other settings). There is also the Vertices number which is the number of vertices
per tooth. See each tooth design mode description to learn if and how this value is used. By
default this is set to 16 which is a bit low for use in physical designs, but good for experimenting
with calculations quickly. Therefore:

(Approximate) Total vertices = (Number of Teeth ) * (Vertices per tooth)
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The total number of vertices directly effects gear calculation time. If your calculations are taking
too long, consider reducing one or both of these values.

5.3 Tooth Design

Just like the base curve design section, there a number of different design modes for creat-
ing tooth shapes, and you can experiment with them simultaneously. Whichever design tab is
currently open contains the current tooth design.

An important feature is the add teeth button. While in any particular tooth design mode,
clicking this button will cause the current tooth design to be used in generating a new tooth-
outline (using your current base curve design) and you will be returned to the active base curve
design mode. Another reason this is useful is that tooth calculation is automatically triggered at
various times when designing base curves, but certain adjustments (such as manually adjusting
the symmetry value) do not trigger an automatic tooth recalculation. For this reason, you can
always click the add teeth button to trigger recalculation of the tooth outline.

The Calculate Teeth tab contains 7 sub-tabs. Six of these tabs are for designing teeth, and
the last is for exporting your tooth designs so you can re-use them later. Listed below are all
the sub tabs in Calculate Teeth tab.

• std - Standard tooth design

• f(t) - Parametric tooth design (Math savvy users only)

• draw - Freedraw tooth design

• img - Image tooth design

• dxf - DXF tooth upload

• txt/csv - CSV tooth upload

• export - Exporting of tooth designs to CSV/DXF

Let’s look at each tooth design mode individually.

5.3.1 STD - Standard Tooth Design

This simply provides some commonly desired tooth designs. Adjust the Vertices value if
desired (higher vertices mean slower calculations but yield smoother designs), and then switch
to whichever design you want: round, square, or triangle. If you change the Vertices you
will need to change to a different tooth design and back so that the tooth design is re-calculated
with the new number of vertices.

W hen you have finished making your selection, click add teeth and return to your active
base curve design tab.
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5.3.2 F(t) - Parametric tooth design (Math savvy users only)

You are able to supply two sets of parametric functions to design each tooth. Your left tooth
should be facing up, and arching downward, and your right tooth should be facing down and
arching upward. Example functions are provided. You are able to set the range values of t
for each set of functions. The Vertices number above will determine how many points the
functions are evaluated at, but this won’t take effect until you use set-left and set-right to
graph the curves. You may enter values such as ’Pi’, ’Euler’, or any expression recognized by
the Expression Parser.

Once you are satisfied with your design, click add teeth and return to your active base curve
design tab.

5.3.3 Draw - Freedraw tooth design

Here you can quickly draw tooth designs using a few simple clicks. In the left hand side of
the display, you create the Left Tooth. The left tooth should be pointing upward, but arching
downward, like this: ∩ In the right hand side of the display, you create the Right tooth. The
right tooth should be pointing downward, but arching upward, like this: ∪.

You may begin by clicking anywhere on the screen. Left click to add a horizontal segment.
Right click to remove the highlighted horizontal segment. The highlighted horizontal segment is
the one nearest the mouse. If you are clicking on the left half of the screen, you will modify the
left tooth. If you click on the right half, you will modify the right tooth.

By default, left-horiz-symmetry is checked. This means if you click near the red vertical
line (the center of the left tooth) an identical vertex will be placed at the same location on the
opposite side of the red vertical line. Similarly, by default right-horiz-symmetry is checked.
This means if you click near the green vertical line (the center of the right tooth) an identical
vertex will be placed at the same location on the opposite side of the green vertical line.

If you uncheck either left-horiz-symmetry or right-horiz-symmetry then you will have
to make two clicks to add a horizontal segment. If you don’t like where you placed a vertex on
the first click, then right click to terminate the segment.

You will also notice that when you modify a left tooth, the right tooth will be modified as
well. This is because the left/right tooth symmetry option is checked by default. You can
uncheck this to draw each tooth individually.

You may use stencil left and stencil right to upload background images to use as stencils,
so you may trace a design from a background image. You may click Clear to erase your design
and start fresh.
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Lastly, to enable the standard zoom controls, click the Pan-Zoom checkbox. Uncheck it to
resume drawing.

Once you are satisfied with your design, click add teeth and return to your active base curve
design tab.

5.3.4 img - Image tooth design

Click the browse button and select a tooth image. For this mode you must have a specially
formatted image to describe your tooth shape. The image must have a solid background color
that is distinct from the contents of the image. This is the only instance where both the left
and right teeth are designed together. To save a thousand words, the image describing the tooth
shape should look something like this:

After uploading, you may select the midpoint of the tooth (it is centered in the image by
default). This is what separates the upper (left) tooth from the lower (right) tooth. You will
almost certainly want to increase the Vertices number above to increase the number of times
the image is sampled. Try to keep the upper and lower peaks of the curves depicted close to
the upper and lower edges of the image, as shown. Lastly you may adjust the tolerance, which
is a value between 0 and 1. Use a high image tolerance (0.5 or higher) when there is stark
contrast between the content of the image and the background (like a black image with a white
background). Use a low tolerance when there is only a slight difference between the content of
the image and the background (like a light-gray image with a white background) Experimenting
with image tolerance will be key to reading the shape as you desire it. (A technical description
of the tolerance is that it is the maximum Cartesian distance within the color-cube that a pixel
can deviate before it is recognized as a non-background pixel).

Once you are ready click Read Image and you will see line segments generated following the
tooth shape depicted. Adjust the number of Vertices as desired, and then click Read Image
again, until the outline is read as you desire. Click Pan-Zoom to re-enable the standard view
controls.
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5.3.5 dxf - DXF tooth upload

Use the two Browse buttons to upload individual tooth designs for the left and right teeth.
The left tooth should be an open curve, pointing upward and arching downward. Like this: ∩.
The right tooth should be an open curve, pointing downward and arching upward. Like this: ∪

The Vertices attribute will determine how many points are used to decompose the DXF files
for each tooth.

5.3.6 txt / csv - CSV tooth upload

Use the two browse buttons to upload individual tooth designs for the left and right teeth.
The left tooth should be an open curve, pointing upward and arching downward. Like this: ∩.
The right tooth should be an open curve, pointing downward and arching upward. Like this: ∪.
Like so:

x0,y0
x1,y1
x2,y2

5.3.7 export - Exporting tooth designs

Use the DXF and CSV buttons to browse to a file location and export the tooth designs.
When exporting to DXF, you have the option of selecting which DXF version you would like to
export to. The resulting export will be split into two files. If you save your file is MyTooth the
files will look something likeMyTooth_left.dxf andMyTooth_right.dxf. The purpose of exporting
individual teeth is so you can design teeth using any of the various design options and save them.
You can then re-upload these files later in the csv / txt and dxf tooth design modes.

5.4 Import full tooth outline

This tab allows you to upload a full tooth outline as either a DXF or CSV file. As before,
CSV files are simply a list of coordinates separated by commas, with one vertex per line. The
contents of the file should look like this:

x0,y0
x1,y1
x2,y2
...

Click the Browse button to the right of the TXT/CSV label to browse to a CSV file and
upload it. Likewise, click the Browse button to the right of the DXF label to browse to a DXF
file and upload it. When uploading the DXF file, you may first adjust the Num Dxf Sample
Points value. DXF files are composed of ’primitives’ such as arcs and ellipse segments. The
number of dxf sample points is used to decompose these primitives into individual line segments.
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The number of points each primitive receives is proportional to the length of that primitive vs.
the total length of the outline curve. So if you specify 1000 sample points and 1/10th of the
length is composed of an ellipse segment, 1000/10 = 100 vertices will be used to approximate
that ellipse segment.

You can use your uploaded tooth outline in combination with any of the base curve design
methods. The currently open design tab in the Base Curve section under the Design tab will
be the base curve that is used. The tooth outline will be visible when designing your base curve,
so you can even use the Draw design mode and trace around the tooth-outline to produce your
base curve.
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Chapter 6

Gear Calculation

6.1 Calculation Parameters

Once you have a base curve and tooth outline prepared, click the Calculate Gear tab at the
top of the user interface.

First, you must set your Rotation Ratio. The rotation ratio is displayed as a fraction. The
ratio is the number of rotations of the known gear (the top number) per rotations of the conjugate
gear (bottom number).

If you set a rotation ratio of ’2/3’ then the known gear will complete 2 rotations for every
3 rotations of the conjugate (calculated) gear. Note you can only set the top number of the
rotation ratio. The bottom number is determined by the symmetry value of your know gear.
This is explained further in the next section Gear Symmetry.

Once you have set your rotation ratio, you may check the Internal option to indicate that
you want the known gear to roll along the inside of the conjugate gear. If you choose this option,
your rotation ratio must have a larger top number than bottom number (this ensures that the
conjugate gear is larger, and therefore the known gear is capable of fitting inside it). If your top
number is smaller than the bottom number, Gearify will automatically make it 1 larger than the
bottom number when you check Internal.

There is also the trim speed slider control. This determines the speed of the calculation. High
trim speed uses fewer iterations to calculate the shape of the conjugate gear, low trim speed uses
more iterations. A high trim speed will work faster, but produces less accurate results. A low
trim speed will take longer to complete, but be much more accurate. You may adjust the trim
speed while the calculation is in progress, but this is not recommended if you are using the
calculation to build a physical model. A technical description of the trim speed is that it is
the angle delta used to rotate the known gear for each iteration of the vertex trimming process,
which is the animation displayed after you click Calculate Gear.
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There is also the Extra High Accuracy check box. For some designs (especially those that
feature teeth with sharp edges) you may see jagged or rippled artifacts on the conjugate gear
after the calculation. To correct these, check the Extra High Accuracy option. This will
perform extra calculations to prevent these artifacts. This is optional as it is often not needed
for good results. Once again, this improves accuracy but slows the calculation speed.

Before you click Create Gear you have the option of selecting an auto-save file, to automat-
ically save the results when your calculation is complete. Simply click Browse select a location
and enter a file name. See Save/Export and Reopening Gearify files for more info on this.

Once you have set all the options described above, click the Calculate Gear button. Gearify
will automatically save to your auto-save file, and transition to theView tab when the calculation
is complete.

Lastly, depending on the quality of your graphics card, the gear calculation could actually be
slowed by the number of lines being drawn during the calculation phase. You can check Hide
Display to prevent this info from being drawn and get a potential speed boost. You are free to
uncheck it and peek on the progress at any time. Don’t worry, after the calculation is complete,
the display will automatically become visible once again.

6.2 Gear Symmetry

Throughout this document, the gear symmetry value has been mentioned countless times.
Gear symmetry is more precisely, radial symmetry. If a gear has a symmetry value of n, then
the gear shape must repeat itself every 360/n degrees. For example, if the symmetry value is 4,
then the same pattern must repeat itself every 360/4 = 90 degrees.

This information is highly important for two reasons.

1. It tells the automatic tooth calculations that the teeth MUST possess the same symmetry.
The tooth patterns must be repeated EXACTLY every 360/n degrees.

2. It determines what sensible rotation ratio you can use. For example, suppose you design
a base curve using the f(t) design mode with r(t) = 3 + sin(3t). This will produce a
symmetry value of 3. The gear has 3 repeating patterns. As a result, the smallest rotation
ratio you should use is 1/3. That is, 1 full revolution of the known gear, 3 revolutions
of the conjugate gear to mesh with the 3 repeating patterns on the known gear. You are
able to increase the ‘top’ number to allow more revolutions of the conjugate gear, but the
minimum value is 1/3. For this reason, Gearify automatically sets the bottom number of
the rotation ratio to be the known gear’s symmetry value. See the Gear Calculation
section for more info on the rotation ratio.

Each base curve design mode has its own way of determining the gear symmetry (see their
individual descriptions for more info). Most modes have an auto-detect, as well as a manual
option to set the gear symmetry value (In case the auto-detect fails).
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If you choose to upload a full tooth outline using DXF or CSV, be absolutely sure that the
symmetry of your tooth outline matches the symmetry of your base curve. Unpredictable results
may follow, otherwise.

One final note. Circles have a radial symmetry value of infinity. This being the case, the auto
symmetry detect reads a value of just 1. You can manually set the symmetry when using a circle
to make sure the tooth calculations and rotation ratio respond accordingly. For example, if you
want to create a pair of circular gears with rotation ratio of 1/4, you can use the f(t) base curve
design mode, uncheck the auto symmetry box, set the symmetry value to be ’4’, then enter a
radius, such as: r(t) =′ 1′, then click graph curve. You will now have a tooth pattern that
exactly repeats every 360/4 = 90 degrees, and the rotation ratio will be automatically updated
to ’1/4’. You could then change the rotation ratio to ’2/4’, ’3/4’, ’4/4’ and so on as desired.
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Chapter 7

Viewing, Saving and Exporting

It is important to view and inspect your gears before exporting. You can also save a gear
design and re-open it to view it again. This chapter will discuss these topics.

7.1 Viewing Gears

Click the View tab at any time to enter this view.

The purpose of this view is to review the results of gear calculations and see them in motion.
You are automatically brought to this view after gear calculation completes. You may enter it
at any time to review a previous calculation.

You may adjust the rotation speed option to increase the speed of motion of the displayed
gears. You may toggle between fixed and orbit mode for two separate rotation styles.

You can set the background color using the color box beside the Background label.

There are two control boxes to adjust each gears appearance. You may toggle between a set of
commonly used textures: wood,stone,metal, use an empty outline or a plainly filled gear and
set the Color. You may also upload a custom texture by clicking the Browse button and then
selecting the custom texture option. After doing so you may click the Adjust button to adjust
the position, orientation and scale of the texture. When in this mode, use the controls at the
bottom of the view tab to toggle between Move, Scale and Rotate. Drag the mouse across the
screen when each mode is active to move, rotate or scale the texture. You may also use the Flip
Horizontal or Flip Vertical buttons to horizontally or vertically invert the image. When you
are done adjusting your texture, click the Done adjusting button to return to viewing mode.
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7.2 Save/Export

To enter this view click the Save/Export tab at the top of the interface.

There are two circumstances where you might want to export:

1. You want to export just your known gear design.

2. You want to export the result of a gear calculation.

If 1: simply enter the Save/Export tab after your design is complete. If2: enter the Save/Export
tab after your gear calculation is complete.

You have various options to determine which features you want to export. Check or uncheck
them to see the effect. In short, what you see is what will be exported.

Sometimes the number of vertices of the tooth outlines can be so high that some users ex-
perience slowness or freezing when trying to open the files in CAD/CAM software. To address
this, there is a Reduce Vertices section. This features slider controls which reduce the number
of vertices in the tooth outlines. Gearify will attempt to distort the design as little as possible
while reducing the number of vertices, but this will inevitably distort the design the more points
you eliminate. So use this option sparingly, if at all!

If you want to export a design to a CSV file, click the Export to CSV button browse to
where you want to save your file. Gearify will split the various items you have checked into
separate CSV files and add suffixes to the file names for you to distinguish them. For example,
if you export your known gear base curve, and your known gear tooth outline, to a file called
myFile, it will export to 2 files that look something like myFile_known_base_curve.csv and
myFile_known_teeth.csv

To Export to DXF click Export to DXF and browse to where you want to save your file.
DXF export (unlike CSV) will export all the selected items to the same file.

An important option on this page is the Offset button. Gearify is capable of producing quite
accurate calculations (assuming you use the right parameters) but if you are using the output
files to build a physical model, it is strongly recommended that you ’shrink’ the tooth outlines
ever so slightly to allow for a small margin of error. Some experimentation may be needed to
determine an appropriate offset amount.

Enter an offset Delta percentage and click the Offset button. The percentage is relative to
the overall size of the gears. This is determined by the maximum distance from the center of
either gear to its respective edge.
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Lastly you may Save your gearify file. This is used only to save the result of a calculation, not
to save your entire design environment (this may be featured in a later revision). Click the Save
File button and browse to a file. Gearify will create a folder with all the necessary info inside it.
If you check the Copy Textures option, any custom textures that you added will be copied into
your saved folder (otherwise they will reference the textures at their original locations). Check
this option if you want to share your design with another Gearify user.

7.3 Re-opening Gearify files

To enter this view, click the Re-open tab.

T o re-open a gearify file, simply click the browse button and browse to a save file you created
previously. There will be a folder with the name you used to save the file, and inside it will be
a file called gear.gearify. Select and open this file. From here you should be able to view and
re-export the file as if you had just created it.

7.4 Chaining Gears

Suppose you want to generate a chain of gears. Gear A connects to B, Gear B connects to C,
C connects to D and so on. Gearify does not explicitly support this design type (though options
to automate this may be available in a later revision) but it is still possible to achieve this.

Simply begin with a gear design, Set your rotation ratio and then calculate your gear. When
you are finished, export your conjugate gear base curve, and your conjugate gear tooth outline
in separate files (CSV or DXF).

Then, re-upload the conjugate gear base curve, and full tooth outline as your known gear, and
repeat the process. Also note, if you simply desire a chain of 3 gears, A connects to B connects
to C, then use B as your know gear and use different rotation ratios to generate A and C.
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Chapter 8

Astronomer

In addition to this tutorial, detailed video tutorials are available on Gearify’s YouTube Channel!

8.1 Extra Easy Quick Start Guide

The later sections describe how to use Astronomer to make very eccentric planetary gears. By
popular demand, a new feature to allow more symmetric, planetary gears is now in place. This
section describes how to use this new feature.

Click the Design tab, and design a gear shape of your choosing, but make sure the shape is
approximately circular, such as a triangle, square, pentagon, hexagon, oval, etc. The closer to a
circle, the better. You may design it using any of the available methods, such as draw or img,
for example. When you are finished, click the Astronomer tab.

Click the CHEAT! checkbox. You may edit the external rotation ratios in either of the
External textfields. The others will update automatically. Once you have one you like, click
Calculate Planetary Gear. You gear will begin calculation. You may now view or proceed
to the Save/Export tab.

NOTES!

1. The number of planet gears will be the Greatest Common Divisor of the Internal and
External values.

2. When designing for a physical model, you will want to visit the Calculate Gear tab and
set the Integration Accuracy to High.

3. The Internal and External values will always differ by twice the value of your gear
symmetry.

4. Most gear shapes that are roughly circular will function, but the less circular the more room
for error is introduced. The only current measure to evaluate the quality of the resulting
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gears is by visual inspection. Have a close look and make sure the teeth are meshing tightly
without slippage or large undercuts.

8.2 Quick Start Guide

Click the Design tab, and design a gear shape of your choosing using any of the available
methods, such as draw or img, for example. When you are finished, click the Astronomer
tab.

In the Variable Known Gear window, left click 4 points inside the gear design to draw a
curve. Right click to erase the curve and start over. Try to draw a curve that spans the overall
length of the gear.

Click the Search button and you will see a red and yellow graph generated in the main display
area. If the graphs intersect, you will see small square markers over the intersections. If this is
the case, click on an intersection, and you will see a purple circle hovering over the intersection.
Then click Calculate Planetary Gears. Your gear will be calculated and displayed within a
few moments. If you do not find any intersections, right click on the Variable Known Gear
window to erase the curve, and re-draw your curve (4 clicks), make sure it spans the full length
of the gear.

The default settings will generate a planetary gear with 3 planets. If you would like a planetary
gear with 4 planets, go to the Rotation Ratios box, and from Numerator. Multiples of 4
from 4 to 4 (External) and 8 to 8 (Internal). Then click Search again. Select your intersection
and click Calculate Planetary Gears as before.

For more options, see the subsequent, more detailed sections.

8.3 Basic Astronomer (Non-Math Users)

T he core concept of astronomer is the following. You draw a curve on your current known
gear design, displayed in the Variable Known Gear window. This tells Astronomer that
it may place the center of rotation of the gear anywhere along that curve. Once you have
placed the curve, drag the slider control inside the Preview V box. This shows the numerical
relationship between a variable called v, and the points on the curve. In short, one end of the
curve corresponds to when v=0, and the other corresponds to when v=1. Astronomer’s job is
to find a specific value of v, that is, a specific point on the curve you drew, that is suitable for
planetary gear creation.

Next you must provide a range of rotation ratios in the Rotation Ratios box (The reason
and purpose of this will be explained shortly). You must provide a range for both internal and
external gear calculations. You only specify the range of the numerator. The denominator of
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the rotation ratio will be fixed, and almost always be 1, except in the advanced mode, explained
in a later section.

Now that you have drawn your center-of-rotation curve, and specified your rotation ratio range
values, you must click Search. What happens is Astronomer will graph a curve for each rotation
ratio you specified in the Rotation Ratios range. The horizontal axis is the value of v, that
is, a specific point on the center-of-rotation curve. The vertical axis, is the spacing (or center
to center distance) between the known gear, and the gear calculated using the given rotation
ratio. Red curves on the graph correspond to external gears, yellow curves correspond to internal
gears. When graphing a curve, it chooses a value of v (a point on the center of rotation curve),
and calculates the resulting gear spacing using the given rotation ratio. Areas where the red
and yellow graphs intersect represent specific values of v (specific points on the curve), such
that an internal and and external gear mechanism have the same center-to-center distance. This
value of v (point on the center of rotation curve) can therefore be used, to compute an internal
and external gear mechanism with the same center to center distance, and therefore create a
planetary gear mechanism.

You may adjust the number of sample points using the slider, just to the left of theV Samples
label. The default is 32. You may reduce the number of sample points of faster calculations, but
this will produce a rough and imprecise graph.

8.4 Number of planet gears, and Rotation Ratio ranges

Recall that you specify a range of rotation ratio values when searching for planetary gears.
When you select an intersection, say between a graph of rotation ratio 3/1, and a graph of
rotation ratio 6/1, the maximum number of planet gears you can place inside the resulting
mechanism will be the Greatest Common Divisor of the rotation ratio (Numerator). The
greatest common divisor just means the highest number that divides both. So in this case, the
greatest common divisor of 3 and 6 is 3. If you found an intersection between a graph with
rotation ratio 10/3 and 15/3, the number of planet gears would be the greatest common divisor
of 15 and 10, which is 5. For this reason, when specifying rotation ratio ranges, you can specify
Multiples of a particular value in the numerator. If you specify multiples of 3 for example, and
provide a range of 3 to 9, it will search the rotation ratios 3,6 and 9. This allows you to find
only intersections where the Greatest Common Divisor will be 3 (or more), so that you can fit 3
planet gears in your mechanism. If you want 4 planet gears, search using multiples of 4. If you
want 5, use multiples of 5, etc. IMPORTANT NOTE! The denominator (or symmetry value)
of the rotation ratio should be left at 1 except for the advanced astronomer mode for math users.
The meaning of symmetry is more delicate since the center of rotation is not going to be at the
center of symmetry. Do not touch the denominator of the rotation ratio unless you are using the
math mode, and fully understand what you are doing. See the Advanced Astronomer section
for more details on this.
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8.5 Accurate Gear Calculation

By default, the accuracy of calculations when using Astronomer are low. This will provide fast
searching, but the results may not be suitable for building a physical model. You may observe
this when viewing a planetary gear mechanism and zooming into the teeth, and notice that they
do not quite mesh accurately. This is not a bug, simply the result of low accuracy settings.

Fortunately, the accurate calculations behave similar to the low accurate calculations. Once
you know what type of design you want, go to the Calculate Gear tab, and in the Integration
Accuracy box, check High. As with the rest of Gearify, you may also want to check the Extra
High Accuracy box, and drag the Trim Speed down to 1,0.5 or 0.25 for best results. Once
you are done, you must return to the Astronomer tab. Search for your planetary gear. The
calculation will be much slower, but will be brutally accurate.

Lastly, after selecting an intersection after using the Search button, you must Refine your
intersection calculation. This will more accurately compute the location of the intersection, so
that the internal and external gear calculated will have a center-to-center distance that agrees
more closely. After you click Refine you will see the two computed distances shown beside the
External Distance and Internal Distance labels. If they do not match accurately enough,
you may repeatedly click Refine to find distances that agree more closely, it should easily be
able to exceed the accuracy that is provided by your CNC machine or 3D printer.

8.6 General Tips

The rotation ratios that are easiest to find planetary gears for, are 3 to 3 external, and 6 to
6 internal. Slightly more difficult, but fairly easy still, is 4 to 4 external, and 8 to 8 internal.
Another useful tip is that if you can find an intersectio between two rotation ratios, you can
increase both rotation ratios by the same ammount and you will typically find an intersection as
well. For example, if you find an intersection between 3 and 6, you will likely find intersections
between 4 and 7, 5 and 8, 6 and 9, etc. Likewise if you find an intersection betweeen 4 and 8,
you will likely find them between 5 and 9, 6 and 10, 7 and 11, 8 and 12.

It is worth mentioning that whenever you test a different value of v, the teeth of the planet
gear are re-calculated in attempt to optimize them based on their current location. In some cases
you may not want this. As an alternative, you can upload a full tooth outline as a file. This full
tooth outline will be used, regardless of the value of v. You do not need to manually create a full
tooth outline, you can Export your known gear tooth outline as a DXF of CSV after creating
your initial design. Then in the Design tab, click the Import Full Tooth Outline tab and
upload your tooth outline.

8.7 Advanced Astronomer (Math savvy users only)

All of the principles of Basic Astronomer apply here with one exception. Instead of the v
parameter corresponding to a location on the curve, the v parameter can be inserted directly
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into your equations in the polar and parametric gear design modes (Under the Design tab,
under f(t) and param respectively). Simply insert v into your functions, and click graph. A
value of v=0.5 will be used in the initial preview, but clicking on the Astronomer tab, you can
drag the Preview V slider and see the gear deform. The value of v will still range between 0
and 1. It has been proven that the amount of variability in graphs generated by astronomer is
bounded (in a particular sense) by the maximum and minimum radius of the gear design. Try
to offer significant difference between the maximum and minimum radius in your design for a
better shot at finding intersections.

Using the math design mode is the ONLY instance where you may want to touch the rotation
ratio denominator. In this case, you will need to make sure that the symmetry about the center
of rotation will hold, For all values of v. For example, the formula

r(t) = 1.01 + (v)sin(3t)

will have radial symmetry of 3 for all values of v. In this case, you would want a rotation
ratio denominator of 3. (Note you need not enclose v in parenthesis as shown above). It is
virtually impossible to achieve radial symmetry using Basic Astronomer. It is possible to achieve
symmetry with parametric graphs, but more difficult. So usually polar graphing will be the only
instance where you’ll use a denominator other than 1.
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Chapter 9

Troubleshooting

Issue: Gearify is running very slow whenever there are any textures or images on screen!

Solution: This likely means your display drivers need updating. The steps for updating your
display drivers will vary per machine so you will need to research this topic online. Generally you
need to determine which graphics hardware you have (make and model) download the appropriate
driver installer from the makers website, and install it on your target machine. If the problem
persists after updating your display drivers, it could be that your graphics card is too old,
outdated or simply not powerful enough, and may need to be upgraded.

Issue: Gearify calculations are too slow!

Solution: Your calculation parameters may be too intense for your machine. Try increasing
the trim speed in the Calculate Gear tab or using fewer teeth, and fewer vertices. Uncheck
the extra high accuracy box if you can afford to. You may need to upgrade the amount of
RAM on your machine, especially if it is fairly old.

Issue: After successfully installing Gearify, I get an error message when trying to run that
says something like: To run this application you must first install one of the following versions
of the .NET framework: v4.0

Solution: You will need to install the .NET 4.0 framework on your machine. See the instal-
lation instructions in Chapter 1 for information on this.

Issue: The software crashed, produced an error dialog, I found a bug, or otherwise Gearify
did not behave as expected.
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Solution: The first thing you should do is to close and re-open Gearify and re-attempt
whatever you were doing. If the problem still persists, restart your computer and see if the
problem occurs again. If it does, send an email to postmaster@gearifysoftware.com and
provide a clear description of what you were doing that produced the error. If you have any
specific files that were involved in producing the error, attach those files in the email.
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Chapter 10

Expression Parser

Operators

• + : Add

• - : Subtract

• * : Multiply

• / : Divide

• % : Modulo

Functions

• sin: sine

• cos: cosine

• tan: tangent

• exp: exponential function (et̂)

• ln: natural log

• acos: arc-cosine

• asin: arc-sine

• atan: arc-tangent

• sinh: hyperbolic sine

• cosh: hyperbolic cosine

• cotan: cotangent

• acotan: arc-cotangent

• sqrt: square root

• fpart: fraction part (fpart(3.71) = 0.71)

• ceil: round up to nearest integer
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• floor: round down to nearest integer

• round: round to nearest integer

• fac: factorial

• sfac: semi factorial (sfac(6) = 6*4*2)

• abs: absolute value

Comparison Operators (All logical expressions evaluate to either 0 or 1)

• <: less than

• <=: less than or equal to

• >: greater than

• >=: greater than or equal to

• ==: equal to

• !=: not equal to

Logical Operators

• &&: and

• ||: or

• !: not

Constants

• euler: 2.71828. . .

• pi: 3.14592. . .

• nan: not a number

• infinity:(infinity > t) = 1 for all t.

• true: 1

• false: 0
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Chapter 11

Credits

Gearify uses unmodified versions of the following LGPL libraries:

• Expression Parser. Author: Patrik Lundin. www.lundin.info/mathparser

• netDXF. Author: Daniel Carvajal. https://netdxf.codeplex.com

• Clipper. Author: Angus Johnson. www.angusj.com/delphi/clipper.php

Special Thanks to all the users of the early version of Gearify, known asGear Creator for
their enthusiastic emails and compliments that motivated me to finish this software.
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